Drag and
Drop
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e Select the file to be attached.

* Click the open button. The file gets
attached to the e-mail.

e (Click the Send button.

The e-mail will immediately send to the
recipient with the attached file.

10. As the name suggests Control blocks let the
user control the blocks within the scrips,
inserting conditions statements, loops,
repeats and pauses. Five Control blocks are:
repeat block, forever block, if.. then block,
it ... then ... else block, stop all.

11. Five applications of machine learning are:
speech recognition, spam detection, social
media, bioinformatics and banking.

Cyber Olympiad
Choose the correct option.
L@ 2@ 3@ 4@
5.d 6 () 7.6 8 (b)
9. @  10.d)  11.(a)  12.(b)
13.(c)  14.(c)  15.(b)  16.(a)
17.(b)  18.(d)  19.(d)  20.(a)
2.b)  22.(c)  23.d)  24.(b)
25.(b)  26.(b)  27.(b)  28.(c)
29.(d)  30.(d)
i Class 72
More on Windows 10
Ectivity Time
1. S 2. S 3. E
4. S 5. E 6. E
7. E 8. S 9. S
10.S
Rapid Fire

1. Control Panel contains several links that is used
to change hardware or software settings.

2. Administrative Tools is example of software
settings.

3. Programs use the date and time to establish when
files and folders are created and modified.

4. You can add one or two additional clocks using
the Additional Clocks tab.

Drag & Drog

Let's Review
A. Tick (V) the correct option.

1. (a) 2. (d) 3. (a)
4. (a) 5. (a)

B. Match the following.
1. (i1) 2. (iv) 3. (v)
4. (i) 5. (1)

C. Answer the following questions.

1. Control Panel is a feature of the Microsoft
Windows graphical user interface that
allows users modify computer's settings and
controls.

2. Follow these steps to change date and time of

a computer:

* Open the Control Panel and click the
Clock and Region link. Date and Time
dialog box appears.

* Click the Change time zone option. A
dialog box appears.

* Click the Change date and time button.
The Date and Time Settings dialog box
appears.

* Make the required changes in date and
time of your system and click the OK
button.

3. Follow these steps to set the double-click
speed of the mouse:

* Open the Control Panel and click the
Hardware and Sound link. A Hardware
and Sound dialog box appears.

* Click the Mouse option in Devices and
Printers section. A Music Properties
dialog box appears.

»  Click the Buttons tab.

e Drag the speed slider in the suitable
direction to set the double-click speed as
slow or fast.

 First click the Apply button and then OK
button.

4. An On-screen Keyboard is a feature provided
by Windows 10. It allows users to type text
using a joystick or a pointing device.

5. Disk cleanup is a utility of a Windows

operating system. It helps to clean up hard
disk.

@ -



P ctivity Time
The students will do it themselves.

Brain Teager

1. Disk Cleanup

2. Defragment and Optimize device
3. Voice recorder or microphone

Animation in PowerPoint 2016
Ectivity Time

Follow these steps to use Disk-Cleanup
utility: 1
*  Click the Start button.
*  Click the Windows Administrative Tools | o

folder

*  (Click the Disk Cleanup option.. 3

¢ Select the drive to be clean up.

+  Click the OK button. The Disk Cleanup | 4
for selected drive dialog box appears.

» Click the check boxes of the files to be
deleted.

*  Click the OK button.

The disk clean up will start for the selected
drive.

We will need a Sound Recorder program to
record our voice in our computer? Follow
these steps to record voice on the computer.

* Open the Control Panel and click the
Hardware and Sound link. A Hardware
and Sound dialog box appears.

e Click the Change system sounds option
in Sound category. A Sound dialog box
appears.

¢ Click the Recording tab.

* Click the Microphone option.

» Click the OK button and start speaking
in the microphone. The voice starts
recording.

Icon | Button Name Group Tab
& Video Media Insert
] Audio Media Insert
, . Start Slide .
o
& |From beginning Show Slide Show
. Transaction .
<l
L] Wipe to This Slide Transactions
% | Add animation | Animation | Animations

Rapid Fire
. PowerPoint was originally developed by Bob

Gaskins.

. In 1988, the first Windows and Dos versions of

PowerPoint were produced.

. You can use the built-in animation effects in

Microsoft Office PowerPoint 2016.

. MS PowerPoint provides four types of
animations.
Let's Review
. Tick (V) the correct option.
1. (b) 2. (b) 3. (¢
4. (¢
. Write T for true and F for false for the following
statements.
1. T 2. F 3. F
4. T 5. F 6. T

Answer the following questions.

1. In PowerPoint is a presentation software
having powerful graphics capabilities and
great formatting features that enable even
the beginners to create professional looking
presentations.

2. Animation is a feature of PowerPoint that
uses drawings, images, and motion to create
a story or image. We can use it to tell a story,
create a character, or show an event.

3. PowerPoint provides four types of animation
to the users. They are: Entrance, Emphasis,
Exit and Motion Paths.

4. The steps to add animation to text or object:
» Select the text or object that you want to

animate.

* Click the Animations tab.

* Click the down-arrow of Add Animation
button in Advanced Animation group. A
list of animation effects appears.

* Select an effect of your choice.

The selected animation effect is applied to

the text or the object.

5. The steps to remove animation effects:

e Select the text or object of which the
animation effect is to bee removed.

* Click the Animations tab.

Drag & Drop



* Click the down-arrow of Add Animation
button in Advanced Animation group. A
list of animation effects appears.

+ Select the None option from the list.

The animation mark will disappear from the
slide and from the Custom Animation task
pane list.

Custom Animation effects are a set of
effects which can be applied in objects in
PowerPoint. It contains a list of animation
effects such as time, style, sound, etc.

Transition effects are special effects used to
introduce slides to move presentations from
one slide to the next.

. The steps to add sound in a presentation:

e Click the Insert tab.

e Click the drop-down arrow of Audio
button in Media group. A menu appears.

e Click the option from where you want to
add.

e Select the audio sound file you want to
nsert.

Click the Insert button. A sound icon will
appear on the slide.

e Click the Play button to play your audio

sound.

X ctivity Time
Icon Name A/T Icon | Name | A/T
% Push T _ k Darken | A
el | Cover | T || Sk | Wheel | A
% | Flyin | A || ©0 | Loop | A
e | Appear | A || | Box | T
B8 | Dissolve | T || ™ | cut | T
B | Doors | T || [ Cél(f:ff T
B | Conveyor | T || ] | Pans | T

Brain Teaser

1. Start Slide Show
2. Setup Slide Show
3. Start Slide Show

Drag & Drog

Formulas in MS Excel
I ctivity Time

Icon Button Name Group Tab
> AutoSum Editing Home
_in_ Paste Clipboard | Home
E‘ Insert row Cells Home
Ef‘ Delete row Cells Home
IE__\ Format Cells Home
- Bottom border Font Home
Rapid Fire
1. The address of a cell or cell range is called cell
reference.
2. Formulas are used to perform calculations with
the given values.
3. The first spreadsheet on a personal computer was
called VisiCalc.
4. AutoSum helps to automatically total the
contents of cells.
Let's Review
A. Tick (V) the correct option.
1. (¢ 2. (b) 3. (¢ 4. (c)
B. Write T for true and F for false for following
statements.
1. T 2. F 3. T 4. F
5. F 6. T 7. F
C. Answer the following questions.

1. Aformulais the most commonly used feature
of MS Excel that has cell numbers, addresses,
arithmetic operators and parenthesis. It
begins with the equal sign (=). For example,
the formula = 5 + 2 * 3, multiplies two
numbers and then adds a number to the
result.

2. In computer programming, operators are
characters that perform specific mathematical
or logical calculations of the given values.
For example, * is an operator that shows
multiplication.

.7 Keys



. In computer programming, concatenation is

the procedure of joining text strings end-to-
end to form a series.

. Steps to create a text formula:

*  Click the cell say A10 cell where you want
to display the result of formula.

»  Typetheformulaas=A2& "hasobtained"
&D2& "percent marks".

e Press the Enter key. The text formula has
created.

. In Excel, functions are predefined formulas

that perform calculations by using specific
values in a particular order. They can be used
to perform simple or complex calculations.

Some functions along with their descriptions
are given in the table given below.

Function Description
SUM It adds values.

It rounds a number specified
by the number of digits.

ROUND

It returns a count of text or
number in a range.

It returns TRUE if all the
arguments are true.

COUNT

AND

. The Excel, AVERAGE function is used to

find the average of the number given to it as
argument.

. Steps to use the Max function:

* Select the cell where Max formula is to be
entered.

e (Click the Formulas tab.

e Click the AutoSum button under
Functions Library.

+  Select the Max option.

* Change the range of cells and press the
Enter key.

The maximum number value will be
displayed as shown.

. AutoSum feature is an important feature of

MS Excel that helps to automatically total the
contents of cells.

Brain Teager
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I ctivity Time
The complete crossword puzzle is given alongside.
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Charts in MS Excel
I ctivity Time
Icon G,F;If:l Use

It is used to display values over

Column | . . . .
m different categories with vertical
chart bars

It can be used to plot monthly
temperature changes or daily
:ﬁ}\}f Line |changes in stock market prices.

chart |[It can also be used to plot
data recorded from scientific
experiments.

It is used to display the
Pie contribution of each value to the
er chart total highlighting the relationship

in terms of percentage of each
value in data to whole.

Bar Itis used to organise the categorise
graph | vertically and values horizontally.
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It is a chart or graph where the
data of various series are separated
Area . R
~ lines and are present in different
chart .
colours. It shows the changes in
various data series over time.
L Scatter |It is used for displaying and
— chart | comparing numeric values.
It is similar to a pie chart but can
‘ J Draught | represent more than one data
chart |series. Each ring of this chart
represents a separate data series.
Rapid Fire
1. A chart presents a large volume of data in easy
format.
2. The area within which all chart components are
found is chart area.
3. A column chart displays data using a vertical bar
or rectangle.
4. Grid lines identify each data series in chart.
Let's Review
A. Tick (V) the correct option.

1. (d) 2. (a) 3. (b)

4. (d) 5. (¢)

B. Write T for true and F for false for following
statements.

1. T 2. F 3. T

4. F 5. F 6. T

C. Answer the following questions.
1. In MS Excel, a chart is a graphical visual
representation of data. Two uses of charts are:
e Charts provide an effective way of
presenting data and information.

¢ They enhance the look of your worksheet
and also present a large volume of data in
easy format.

2. There are many types of charts in MS Excel.
Some of them are: column charts, line charts,
pie charts, bar charts, area charts, scatter
charts, stock charts, surface charts, draught
charts, bubble charts and radar charts.

3. In a column chart, the variable value is
plotted vertically and the fixed dimension
horizontally; whereas a bar chart plots the
variable value horizontally and the fixed
dimension vertically.

Drag & Drog

4. A pie chart, also called the circular chart,
displays data in a circular-shaped graph. The
whole circle is divided into sections or sectors
to represent values of different sizes.

5. A scatter chart is a type of chart uses dots to
represent values for two different numeric
variables.

The main difference between a scatter chart
and a line chart is that a scatter chart displays
the values at irregular intervals whereas a line
graph displays each data series in a straight
line of different colour.

6. The chart area is the area inside the chart
window including all parts of the chart are
displayed, whereas the plot area refers to the
region that represents the plotted data in a
chart.

7. A data series refers to a row or a column of
numbers that are entered in a worksheet and
plotted in the chart

8. Steps to create a chart:

 Select the cell range in the worksheet for
which you want to make a chart.

e Click the Insert tab.

e Click the Insert Column or Bar Chart
in Charts group. A list of column charts
appears.

e Click the Clustered Column in 2-D

Column section.

The selected data is selected in 2D-column
chart and chart is formed in a box in the
centre of the worksheet.

Brain Teager
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I ctivity Time

1.

The given chart shows a doughnut chart, which
is similar to a pie chart. But a doughnut chart can
represent more than one data series. Each ring of
this chart represents a separate data series.

@ -



2. The given picture shows a radar chart, which
plots data on concentric circles with the data
of the same data series connected by lines. It
compares the aggregates values of a number
of data series. It looks like a spider's web

Model Test Paper — |

. Tick (V) the correct option.

. (0 2. (d) 3. (b) 4. (b)

5 (c) 6. (a) 7. (d) 8. (b)

9. (c) 10. (a) 11.(b) 12.(b)

13.(a)

Fill in the blanks.

1. You can make changes in the setting of date
and time by using Control Panel.

2. Cleanup utility program helps to clean
unnecessary files from hard disk.

3. Timing button helps to set the speed of the
slide transition.

4. MS PowerPoint provides four types of
animation.

5. In a worksheet in MS Excel, a complete row
of information is called cell.

6. Filtering is a feature that hides the data you
do not want to see.

7. The Sort & Filter button is in Cells group.

8. An operator is used to perform calculation on
the given values.

9. Status bar is located at the bottom of the

Editor Screen in QBasic.

10. A string variable stores string data.

C. Answer the following questions.

1.

Keys "

The Control Panel is a very important feature
of the Microsoft Windows graphical user
interface. It allows users modify computer's
settings and controls.

Some examples of hardware
settings are: display, keyboard and mouse
settings.

Examples:

On-Screen Keyboard is a feature provided by
Windows 10 It displays the characters that
are used to write or create documents.

Custom Animation feature of contains a
list of animation effects such as time, style,
sound, etc., which can be applied to objects

10.

to have them animated during the slide show.
It can be used for entertainment.

Transition effects are special effects used
to introduce slides in a presentation. They
determine the movement of one slide to the
next in a presentation.

Follow these steps to add sound in a

presentation:

»  Click the Insert tab.

» Click the drop-down arrow of Audio
button in Media group. A menu appears.

»  Click the option from where you want to
add.

¢ Select the audio sound file you want to
insert.

»  Click the Insert button. A sound icon will
appear on the slide.

 Click the Play button to play your audio
sound.

Operators are an important feature of MS

Excel that are used to perform calculations on

the given values.

The Min function is used to get the smallest

value in a range of values.

Steps to create a text formula in MS Excel:

* Click the cell, say A10 cell, where you
want to display the result of formula.

»  Typetheformulaas =A2& "hasobtained"
&D2& "percent marks".

* Press the Enter key. The text formula has
created.

Steps to change date and time of a computer:

* Open the Control Panel and click the
Clock and Region link. Date and Time
dialog box appears.

* Click the Change time zone option. A
dialog box appears.

* (Click the Change date and time button.
The Date and Time Settings dialog box
appears.

»  Maketherequiredchangesindateandtime
of your system and click the OK button.

The basic elements of QBasic program are:

operators, variables, constants, and a set of
characters.

Drag & Drop



CEEEREE More on QBasic

Ectivity Time
The labelled QBasic window is given below.
Program Title

Vertical Scroll Bar
oo

Menu Bar

P
B[ D:\QBASIC\QBASIC.EXE
File Edit Uiew Search

{Shift*Fi=Help> <F6=Window> (F2=Subs> <{F5=Run> <F8=Step)>

Im}nediate
Mode Area

HoriontaI
Scroll Bar

J [
Program Status Bar

Area

P ctivity Time
The Basic statements of QBasic are circled in the
alongside grid.

A|M|O/E|Q|G|D|T
1/S|RIE|M|R|U|S
N|P|N|R|Q|P|M| D
PR/ C|T|C|B|C|L
ul1[u]E[N[D|L|A
TIN|L|V|] 1|8z
B|T|W|F X|F|Y H
D K|E|N/L/E|T|Q
Rapid Fire
1. Status bar is located at the bottom of the Editor
Screen.

2. A number with or without decimal point is a
numeric constant.

3. A string variable stores string data.

4. END statement is used to indicate the end of a
program.

5. The four types of operators are Arithmetic,
Relational, Logical and String operators.

Let's Review
A. Tick (V) the correct option.

1. (a) 2. (c) 3. (d)
4. (b) 5. (a)
Drag & Drog

B. Write T for true and F for false for following

statements.
1. T 2. F 3. T
4. F 5. T

C. Answer the following questions.

1. QBasicisa high-level programming language
developed by the Microsoft Corporation.
It was developed for the use in MS-DOS
operating system. The successor of BASIC,
it 1s an ideal programming language for
beginners.

N

Follow these steps to run a QBasic program:

¢ Double-click the icon of QBasic on the
desktop. The QBasic window will open
with a Welcome dialog box.

» Press the Esc key to hide the Welcome
dialog box and start working on it.

o

The basic elements of QBasic program are:
operators, variables, constants, and a set of
characters.

A

A variable in QBasic is one of its features
that has been given a name. Its value can be
changed any number of times as required
during the execution of a program.

5. PRINT statement is used to display message
or result on the screen. Characters or
sentences should be written within inverted
commas (“ 7).

=

INPUT statement allows users to input the
information when the program is already
running. This command waits for the user
to enter the information and then assigns the
information to a variable.

Brain Teager
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Flash: An Introduction
P ctivity Time

Elements and tools of Flash window are circled in
the grid.

Al e
C|B|T J
LiB|T N
1|/D|M R|L
NP |E! K|Y
E|R[L 0l X
T|L[T] VI|H
siQIN[P|lE[T|G|F[AlG
U|R[E[CIT/AIN|G|L|E
X|W[IVIO| ] |M|H|K|L|N

Rapid Fire

1. The word animation is a form of animate which
means 'to bring to life'.

2. Timeline contains frames, which play an

important role in making animations.
3. Line tool is used to draw straight lines.

4. Paint Bucket tool also provides modifiers which
allows you to close gaps in shape's outlines.

Ectivity Time
The complete labelled Flash window is given below.
Tool Bar Menu Bar Timeline — Library

SHE

| [
Property Inspector Stage

Let's Review
A. Tick (V) the correct option.

1. (b) 2. (¢ 3. (a)
4. (d) 5. (¢)

B. Write T for true and F for false for the following
statements.

1. T 2. F 3. F
4. F 5. F
C. Match the following.
1. (iii) 2. (v) 3. (1) 4. (i1)

D. Answer the following questions.

1. Animation is a way of displaying unmoving
images in a rapid sequence to create the
illusion of movement.

2. Macromedia Flash is a multimedia software
used for creating animations, games,
cartoons, websites, graphic effects, text
effects and special effects. It is one of the
most popular technologies on the Internet.

3. Property Inspector, appears at the bottom of
the Flash window, is the panel that displays
the properties of the selected object.

4. Polystar tool is a drawing tool used to draw
polygons and stars.

5. Steps to draw a rectangle:
*  Click the Rectangle tool.

e Select the desired stroke colour and fill
colour.

»  Click the Stage and drag to draw a shape.

The shape so drawn is a rectangle.
Brain Teager
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HTML: An Introduction
I ctivity Time

The names of HTML tags and attributes are circled
in the grid.

AWIQITIE|X|T|R|T|S
X|H|{U|V|P|A|/A|B|U|H
Y|IT|IT|T|L|E|I|G|H|R
O|M|I|[S|T|Z|B|C|F|G
P|L|B|/R|R|B|B|O|]J|K
N|H|C|G|H|D|G|C|P|Q
M|B|D|F|E|/M|E|F|O|E
T[O|P|M|A|R|G|I|[N|D
I|D/M|L|D|/K|IN|T|C|L
JIY|H|B|G|[C|O|L|O|R
Drag & Drop



Rapid Fire

1.

2
3.
4
5

Drag & Drog

Empty tags do not require closing tags.

. Heading tag can have value from 1 to 6.
HTML was developed in 1990.
. Body tag appears just after the HEAD tag.
. Microsoft FrontPage is an example of
WYSIWYG editors.
Let's Review
. Tick (V) the correct option.
1. (b) 2. (b) 3. (a)
4. (c) 5. (b) 6. (c)

Write T for true and F for false for following
statements.

1. T 2. F 3. T
4. T 5. F 6. F
7. T

. Answer the following questions.

1. HTML, stands for Hyper Text Markup
Language, is a standard markup language
for creating web pages to display on World
Wide Web. The latest version of HTML 1is
HTMLS.

2. Some of the features of HTML are:

e HTML gives the text an attractive
appearance.

e It can display any kind of document
from any computer on the host computer
anywhere in the world.

e It links various documents with one
another.

o It is a versatile language suitable for use
on such diverse platforms as Machintosh,
Windows, etc.

3. The two types of HTML editors are Text
Editors and WYSIWYG Editors.

4. HTML tags are elements of HTML. They
are like keyword that tell a web browser how
the format and display the content must be
on the web page.

5. HTML attributes features that provide extra
information about HTML elements. They
are always specified in the start tag.

6. A body tag can have a number of attributes
that are used to describe the formatting

features for the entire body of HTML
document. Text is an attribute of body tag. It
is used to set text colour to the body text. The
value can be a colour name or a hexadecimal
code.

7. Steps to view HTML document in Internet

Explorer

*  Open the Internet Explorer and click the
File menu. A menu appears.

» Click the Open option. The Open dialog
box appears.

* Click the Browse button. The Windows
Internet Explorer dialog box appears.

» Select the location and choose the html

file.

» Click the Open button. The path will be
displayed in the Open dialog box.

+  Click the OK button.
The Internet Explorer will display the web
page created by you as shown below.

8. The <br> tag is an empty tag which means it
has no end tag. It is used to insert a single line
break. Syntax:: <br>

The <title> tag defines the title of the
document that is seen in the title bar of the
web page. Syntax: <Title> ... </Title>. The
text in-between <Title> ... </Title> tags
creates the page title.

Brain Teager
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Computer Networking
Rapid Fire

1.

The computers are connected in a network to
exchange information and data.

2. LAN stands for Local Area Network.
3. TheWide AreaNetwork is the best known WAN.

4. A network can be made in five different

topologies.
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5. Star Network topology is very easy to add and

remove without disturbing the network.

P ctivity Time
1.
2.

Keys "

The students do it themselves.
From the left:

Bus Network Topology

Tree Network Topology

Ring Network Topology

Let's Review

. Write T for true and F for false for following

statements.

1. F 2. T 3. F

4. T 5. T 6. T
. Match the following.

(a) (it1) (b) (v) (c) (iv)

(d) (i) (e) (1)

. Answer the following questions.

1. Networking is a vital factor for the successful
working of information systems. There are
various networking systems. For example,
television networks, railway networks,
post and telegraph networks and computer
networks. But the contributions of computer
networking are significant.

2. A computer network is a set of computers
connected through a communication media
to share and exchange information. Each
computer in a network is called a node.

3. The main advantages of computer network
are:

o It allows different users to share the
processing characteristics of different
computers.

e It allows the users to share common set
of data files and software stored in a main
system.

e It allows the users to share common
hardware resources such as printers,
scanners, modem, etc.

e The cost of computing is reduced to each
user as compared to the development and
maintenance of each single computer
system.

4. LAN, stands for Local Area Network, is

generally limited to a geographic area such
as a lab, school or building; whereas WAN
(Wide Area Network) has connectivity
spread over large geographical areas from
country to country.

5. The geometrical arrangement of computer
resources, remote devices, communication
facility is known as a network topology.

CFEER Introduction to Visual Basic

A.

Let's Review
Tick (v') the correct option.

1. (b) 2. (a) 3. (b)

4. (c) 5. (a)

Write T for True or F for False statements.
1. F 2. T 3. T

4. F 5. F 6. T

Match the following tools with their related
terms correctly.

1. (b) 2.
4. (e) 5.

(d) 3.
(c)

(a)

. Answer the following questions.

1. Visual Basic differs from basic in many ways
such as:

*  Visual

programming language that supports

events handling, while BASIC is a

procedure-oriented language.

Basic is an object-oriented

* In Visual Basic, programming is done
in a graphical environment; whereas in
BASIC, programming is done in a text-
only environment.

e In BASIC, users need to specify its
position and other features by writing
statements; Whereas in Visual Basic,
users just need to drag and drop any
graphical object anywhere on the form,
and they can change its properties using
the properties windows.

2 (a) Properties are the characteristics such as
name, caption, appearance, and font, of
the form or an object.

(b) Methods are actions, such as show, hide
and print, performed on the form or
objects.

(c) Events are messages sent by an object
indicating that something has happened.

Drag & Drop



3. The three steps to create an application in
Visual Basic:

¢ Design the interface.
» Settheproperties on the controls (objects).

¢ Write the event procedure.

4. The steps to calculate the area of a square in
Visual Basic:

We know that: area of a square = side X side.
Start Microsoft Visual Basic 6.0.

¢ Design the interface. For it you need to
place various controls on the form. To
place a control, double-click the required
control button, such as name or label. The
required control appears in the middle of
the form.

¢ Set the properties of the controls, such as
title name, dimension of the square.

e Write the event procedures such as side
of the square. Finally, write the event
procedure for calculating area by clicking
the command button.

* Run the program by pressing <F5> key.
You will get the result as output.

5. The students will do it themselves, following
the steps given in problem on page 94 of the
book. The teacher will help students in doing
so.

6. The students will do it themselves, following
the steps given in problem on page 94 of the
book. The teacher will help students in doing

SO.
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. The term related to Visual Basic Form are circled

in the grid.
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2. The labelled tool box picture is given below.

Combo Box

Pointer —~ k Picture Box
Label —«A ah|—— Text Box
rXy—,
|

Frame —=
CheckBox —+ [ (& ~—— Option Button

Ed E8
Horizontal

Scroll Bar 4l 2

Command Button

List Box
:II —— Vertical Scroll Bar

Timer ——- |@ EI._ Drive List Box

Directory

List Box —*,_] ~—— File List Box

Shape —*@ “~. — Line

Image —* % Data

Brain Teaser

1.

Form window is the main work area of Visual
Basic window. It is because the users design the
form for his/her application by placing different
objects in this area.

The two properties that can have True or False
value are: Visible property and Enabled property.

The label provides instructions and guides to
the users, whereas the text box is the standard
control for accepting input from the user and
displaying the output.

We should not use the built-in control names of
Visual Basic because it gives controls a default
name.

Introduction to Python
Rapid Fire

. Python is an interpreted, object-oriented, high-

level programming language.

The two modes that Python has are Interactive
and Script.

Two points to show the drawbacks of Python:

.7 Keys



e The Python programming language uses
a large amount of memory. This can be a
disadvantage while building applications
when we prefer memory optimization.

e Programming in Python is easy and stress-
free. But when someone is interacting with

the database, it lacks behind.

. In Python, a string value is a collection of

Keys "

characters (text) put in single or double quotes.

Let's Review

. Tick () the correct option.

1. (o) 2. (o) 3. (0)
4. (b) 5. (a)

Fill in the blanks with the correct words given
below.

1. The storage unit of data is called a variable.

2. Thetwo modes that the IDLE Python has are
Interactive and Script.

3. The separator "\n' is used to display new
lines.

4. The script mode gives the output instantly.

. Write T for true and F for false statements.

1. F 2. T 3. F
4. T

. Answer the following questions.

1. Pythonisahigh-level programming language
used worldwide. It is simple and easy to learn
syntax emphasizes readability. Because of
it, the cost of program maintenance is less.
It supports modules and packages, which
encourages program modularity and code
reuse.Python is used to crate games, write
GUTs, and develop web applications.

2. Some of the drawbacks of using Python
language are: Slow Speed, Not Memory
Efficient, Weak in Mobile Computing,
Database Access, and Runtime Errors:

3. Data type signifies the type of the variable,
whether it is an integer variable, string
variable, tuple, dictionary, list, etc.

In Python, three data types in numbers
are integer, floating number, and complex
numbers, which are defined as int, float
and complex class respectively. Integers are
positive and negative numbers together with

zero. An integer in Python can be simply
declared by simply writing variableName
= initial value. For example, age = 25,
mobile number = 12345678. Float stands
for numbers that have decimal parts such as
3.06, 0.87, —2.55, etc. A float in Python can
be declared by simply writing variableName
= initial value. For example, user's weight =
43, user's height = 5.2.

. Script mode is used to write longer Python

codes. Script mode is where we write our code

in a .py file and then run it with the python

command.

To run a Python program in Script mode, we

follow these steps.

*  Open the IDLE Shell window and click
the File tab.

» Click the New File option. A new window
opens.

*  Write your code in the new window.

* Click File — Save option. The Save As
dialog box opens.

e Write the name of your file name in the
File name box.

*  Press the Save button.

« After saving the file, click the Run tab. A
box appears.

»  Click the Run Module option or press I'5

key. The output appears on the Python
shell window as shown.

. In Python, variables are storage units for

data. A Python variable is a reserved memory
location to store values. In other words, a
variable in a Python program gives data to
the computer for processing.

To assign the value of a variable in Python,
equal sign (=) is used. Thus, we assign the
value on the right side of the equal sign (=) to
the variable on the left. For example, m = 27.
Here, the value of mis 27.

. In Python, we use input() function to get

input from the user. The input function
converts it into a string. For example:

name = input('Enter you name:')

print('Hello,',name)
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Rapid Fire

The complete crossword puzzle is given alongside.
Artificial Intelligence (Machine
Learning)

Rapid Fire

1. Unsupervised machine learning does not need

any labelled data to perform a task.

2. Thethreevirtual personal assistants are: Cortana,

Alexa and Sir1.

3. Types of supervised machine learning are:

classification and regression.

4. The two types of unsupervised machine learning

are: clustering and association.

Let's Review

A. Tick (V) the correct option.
1. (o) 2. (c) 3. (b)
4. (¢) 5. (¢)

B. Fill in the blanks with the correct words given

below.

1. Sophia is a citizen of Saudi Arabia.

2. Sophia is a humanoid designed by Hong

Kong-based company.
3. Alexais a virtual personal assistant.

4. Regression is the problem of predicting
continuous quantity output for an example.

5. Romeo is a human-sized robot that has been

designed to assist the elderly people.

C. Write T for true and F for false statements.
1. F 2. F 3. T
4. F 5. F

. Answer the following questions.

1. Artificial intelligence is the ability of

computer program or a machine to think and

learn.

2. Machine learning the branch of artificial | B-

intelligence.

3. Machine learning is an application of
artificial intelligence that enables machines
like computers to improve at tasks with

experience.

4. There are also three branches of machine
learning: supervised learning, unsupervised

learning and reinforcement learning.

Drag & Drog

a

a

Supervised learning applies past experiences
labelled for model to be trained, whereas
unsupervised learning uses neither classified
nor labelled data for model to be trained.

Reinforcement machine learning is different
from supervised machine learnings in the
following wasys.

* Reinforcement machine learning does not
need the labelled data, whereas supervised
machine learning needs labelled data.

* Reinforcement machine learning is a
trial-and-error based machine learning
technique, whereas supervised machine
learning applies past experiences

The categories of supervised machine
learning are: classification and regression.
Classification predicts the class of the given
data. Regression learns from the labelled
data and applies it to predict a continuous
valued output.

A robot is a human-shaped machine that can
execute specific tasks with little or no human
intervention and with speed and precision.

Robotics is a branch of artificial intelligence
that involves the conception, design,
manufacture and operation of robots. For
example, robots are used in restaurants
to prepare food. They are also work as

receptionists, cleaners and servants in
restaurants.
Model Test Paper — Il

Tick (v') the correct option.

1. (b) 2. (a) 3. (0

4. (b) 5. (¢) 6. (¢

7. (c) 8. (d) 9. (a)

10.(d) 11.(b) 12.(a)

13.(b)

Fill in the blanks.

1. Line charts are used to plot data recorded
from scientific experiments.

2. The & sign is used to join two or more string
data.

3. The Cls or Clear statement is used to clear the
output screen.

4. The Gradient Fill tool is linked with Paint

Bucket tool.
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10.

11.
12.

Notepad is an example of Text editor.
Empty tags do not require an ending tag.

The (<Body>)
(/<Body>) tags is displayed in web browser.

content 1in-between

The Internet is best known Wide Area
network.

When the user clicks on the form, Form-click
event is triggered.

Form Layout Window displays the position
of the form on screen.

Python is a high-level language.

The United Nations has given Sophia the
title of Innovation Championship.

C. Answer the following questions.

1.
2.

Keys "

A chart is a graphical representation of data.

A pie chart represents data in a circle with
sections corresponding to percentages of
the whole, whereas a bar graph uses bars
(rectangles) of different lengths to represent
data.

A numeric constant is a number with or
without decimal point. It consists of an
integer, a decimal point, and a fraction or
exponential notation.

Control statements help programmers to
control the flow of the program according
to their choice. These are powerful tools for
programmers. The two control statements

are GOTO, and DO LOOP.

Flash one of the most popular technologies
on Internet because it is an animation
creating animations,
games, cartoons, websites, graphic effects,
text effects and special effects.

software used for

Polystar tool is a drawing tool used to draw
polygons and stars. The user can modify it in
terms of the number of sides of the polygon
or the number of points on the star which can
vary from 3 to 32.

The three features of HTML are:
e HTML gives the text an attractive
appearance.

e It can display any kind of document
from any computer on the host computer
anywhere in the world.

10.

11.

12.

e It links various documents with one
another.

WYSIWYG editor is a type of editor that
allows the user to create web pages without
knowing how to write HTML codes. It allows
the user insert tables, hyperlinks, images,
etc. Adobe Dreamweaver and Microsoft
FrontPage are two examples of WYSIWYG

editors.

Computer network is advantageous in the
following ways:

e It allows different users share the
processing characteristics of different

computers.

e It allows the users share common set of
data files and software stored in a main
system.

e Jt allows the users share common

hardware resources.

* The cost of computing is reduced to each
user as compared to the development and
maintenance of each single computer
system.

A computer or device which is in a network is
called a node.

We follow these steps to calculate the area of
a square in Visual Basic:

We know that: area of a square = side X side.
 Start Microsoft Visual Basic 6.

* Design the interface. For it you need to
place various controls on the form. To
place a control, double-click the required
control button, such as name or label. The
required control appears in the middle of
the form.

 Set the properties of the controls, such as
title name, dimension of the square.

*  Write the event procedures such as side
of the square. Finally, write the event
procedure for calculating area by clicking
the command button.

* Run the program by pressing <F5> key.
You will get the result as output.

A data type, in Python, is a classification that
specifies which type of value a variable has
and what type of mathematical, relational or
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logical operations can be applied to it without
causing an error.

13. Interactive mode is a command line shell
which gives immediate response to each
statement, whereas Script mode is used to
write longer Python codes. Interactive mode
has three arrows >>> as prompt, whereas in
Script mode the prompt is .py.

14. The main difference between supervised
and unsupervised machine learning is that
supervised machine learning uses labelled
data while unsupervised machine learning
does not use such data.

15. (a) Buddy: It is a companion robot designed
to entertain the family. This endearing
emotional robot wins the heart of every
member of the family, including children
and adults. As a real companion, it can
walk around house like a pet.

(b) Sophia: It is a social humanoid robot
developed by Hong Kong-based
company Hanson Robotics. It is capable
of imitating human gestures and thus is
capable in answering questions. She has
been given official citizenship in Saudi
Arabia. The United Nations has given
her the title of Innovation Championship.
Sophia has appeared in several high-
profile interviews and appearances.

Cyber Olympiad
Choose the correct option.
1. (c) 2. (b) 3. (a)
4. (d) 5. (d) 6. (a)
7. (b) 8. () 9. (b)
10. (¢) 11.(b) 12.(b)
13.(¢) 14.BYRE 15.(d)
16.(d) 17.(d) 18.(d)
19.(¢) 20.(a) 21.(b)
22.(d) 23.(d) 24.(d)
25.(a)
) Class [ 82
Computer Virus
X ctivity Time
1. MV 2. BV 3. PV
Drag & Drog

4. TH 5. W 6. MRV
7. PV 8. TH 9. PV
10. MRV

Brain Teager

1.

The full form of VIRUS is Vital Information

Resources Under Seize.

The first virus to ever be identified was known as
the Creeper.

3. Acid Rain is an example of Program Viruses.

4. Worms generally spread through e-mails and

networks.

Let's Review

. Tick (v) the correct option.

1. (c) 2. (a) 3. (o)
4. (a) 5. (¢)
Fill in the blanks.

1. A virus can destroy files, software and
program applications.

2. A virus can reproduce itself without any user
action.

3. Macro viruses infect files that are created
using certain applications or programs.

4. Stoned virus is an example of Boot viruses.

5. Commwarrior was the first known cell phone
virus.

6. You can prevent virus infections by using
Antivirus software.

7. Memory Resident virus get control over the
system memory.

Answer the following questions.

1. Acomputervirusisatypeofcomputerprogram
that has replicating capabilities. When
executed, it replicates itself by modifying
other computer programs and causing loss
of data.

2. Some of the sources of computer virus are:
Internet, Email attachments, computer
network removable devices and Bluetooth
transfer

3. We can know that our computer is attacked
by a virus by following symptom:s:

» The computer runs very slow and it takes
along time to start.
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